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Preface

Purpose

The Teradata® Tools and Utilities are a group of products designed to work 
with the Teradata Database. This user guide describes Teradata Dynamic Query 
Manager, and the client components and features. Teradata DQM allows you to 
schedule SQL requests to a DQM Scheduled Requests server, and view 
information about your scheduled jobs.

Teradata DQM lets the Teradata database administrator (DBA) manage and 
regulate networked access to the Teradata Database.

Supported Releases

This book supports the following releases:

• Teradata Database V2R5.1
• Teradata Tools and Utilities 07.01.00
• Teradata DQM 05.01.00

Teradata DQM 05.01.00 supports V2R5.1.

Teradata DQM 05.00.00 only supports Teradata V2R5 or later. Teradata DQM 
04.03.00 supports Teradata V2R4.1 or V2R4.2.

Changes to This Book

The following changes were made to this book to support the current release:

Date/Release Description

September 2003/ 
07.01.00

Changed TDQM version from 5.0 to 5.1.

TDQM Administrator now provides a monitoring capability for delayed queries, such that 
the display is automatically updated rather than requiring the user to go through a 
sequence of menu selections to obtain a new set of delayed query information.

Changed error log format to remove the date, since files are now date-specific.

Removed the automatic invocation of the Connect dialog box in the Scheduled Request 
Viewer application, as failures to connect cause the main viewer dialog box to invoke.

Added a DQM Server ID to the Server Information Dialog box, General tab, so that the 
unique internal numeric identifier assigned to each TDQM server system is displayed.

Added Refresh command to the TDQM Administrator View menu, so data is reloaded 
into all windows.
Teradata Dynamic Query Manager User Guide i
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Added Cleanup command to the TDQM Administrator main window to remove database 
objects that no longer exist, and then refresh all windows.

Added the ability to save large objects into results tables and files and support for large 
objects when scheduled requests include large objects.

Updated the Job List in the Scheduled Requests Viewer so that when the current job is 
“failed,” the Information field maps one of the following states to the general job failure 
status.

• Existing results could not be dropped
• Server down
• System error
• Error on drop results
• Error on open results
• Error on write results

Windows 98 for Client components no longer supported.

December 2002/ 
07.00.00

Teradata Dynamic Query Manager is abbreviated as Teradata DQM or DQM. Occasionally, 
you may see it abbreviated as TDQM when referring to elements in the user interface.

The word "restriction" has been replaced by "rule."

Generate an e-mail notification when a scheduled request has completed. 

Date/Release Description
Teradata Dynamic Query Manager User Guideii
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Audience

This book is for Teradata DQM users. Database administrators using Teradata 
DQM to manage users’ requests sent to the Teradata Database may find it 
helpful. You should have a good understanding of the Teradata Database and 
be familiar with Microsoft® Windows®.

Prerequisites

This book is a user guide and requires no prerequisite reading. You should be 
familiar with:

• Basic concepts of the Teradata Database
• Relational database management systems
• Teradata SQL
• Connectivity software, such as ODBC and CLIV2

Product Related Publications

The publications that support the DQM product are listed below. In the 
following table, the mmyx represents the publication date, where mm is the 
month, y is the last digit of the year, and x is an internal publication code. 

Teradata Tools and Utilities Release Definition

The Teradata Tools and Utilities Release Definition gives you any additional 
information received late in the release process that may not have been 
included in this document.

You can also find a list of: 

• Operating systems and Teradata Database versions that the Teradata Tools 
and Utilities release are certified to work with

• Product release version numbers
• Documentation that supports the current release
• Training and support centers

B035-2496-mmyx Teradata Dynamic Query Manager Administrator Guide

B035-2509-mmyx ODBC Driver for Teradata User Guide

B035-2428-mmyx Teradata Manager User Guide

B035-2430-mmyx Teradata SQL Assistant for Microsoft Windows User Guide
Teradata Dynamic Query Manager User Guide iii
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Technical Information on the Web

For technical support, additional information, or the latest versions of Teradata 
publications, you may access online information through the following NCR 
Web sites:

List of Acronyms

The following acronyms are used in this book:

http://www.info.ncr.com/ A direct link to NCR Information Products Publishing 
library where you can view, download, or order 
technical documentation and CD-ROMs.

You can also find a Documentation List link for each 
Teradata Tools and Utilities release. The 
Documentation List identifies all publications released 
in support of the current Teradata Database and the 
Teradata Tools and Utilities release.

 Teradata.com The NCR home page provides links to numerous 
sources of information about Teradata. Among the 
links provided are sites that deal with the following 
subjects:

• Technical support
• Customer education courses
• Case studies of customer experiences with 

Teradata
• Third party industry analyses of Teradata data 

warehousing products
• White papers
• Online periodicals

ASCII American Standard Code for Information Interchange

DBA Database Administrator

DBQM Database Query Manager

DQM short acronym for Teradata Dynamic Query Manager

EUC Extended UNIX Code

ID Identifier or Identification

JIS Japanese Industrial Standards

ODBC Open Database Connectivity

RDBMS Relational Database Management System

SQL Structured Query Language

TDQM Teradata Dynamic Query Manager
Teradata Dynamic Query Manager User Guideiv
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Chapter 1: 

Product Overview

This chapter provides an overview of DQM and contains the following 
information:

• Introduction 
• DQM Client Software Components 
• DQM Architecture 
• Installation Information 
• Software Configuration 
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Chapter 1: Product Overview
Introduction
Introduction

What is DQM?

DQM lets your DBA manage access to and utilization of the Teradata Database. 
Managing database access increases database efficiency and workload capacity. 

DQM manages database access and use by:

• examining logon and query requests, comparing the objects referenced in 
the requests to DBA-defined rules, and rejecting requests meeting the rules 
criteria. To learn more about these query management features, refer to the 
Teradata Dynamic Query Manager Administrator Guide.

• accepting single or multiple statement query requests for scheduled 
execution at a later time. Scheduled requests are also subject to restriction 
checking. 

This user guide explains the scheduled requests capabilities of DQM which is 
provided to you when you install the Teradata DQM scheduled requests client 
software.
Teradata Dynamic Query Manager User Guide1 – 2
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DQM Client Software Components
DQM Client Software Components

DQM has the following client software components: 

• Teradata DQM Scheduled Requests Operations
• Teradata DQM Scheduled Requests Viewer

Teradata DQM Scheduled Requests Operations Utility

Teradata DQM Scheduled Requests Operations is a part of the DQM scheduled 
requests client software. You can use it to:

• Configure the scheduled requests client environment on your PC
• View information about client parameters, connections, processes, and 

statistics
• Examine DQM error log files

Your DBA uses this utility to configure and monitor the Teradata DQM 
Scheduled Requests client and server components. 

Teradata DQM Scheduled Requests Viewer Application

DQM provides an application for Windows from which you can manage your 
scheduled requests. The Teradata DQM Scheduled Requests Viewer allows you 
to:

• Submit new requests
• Create a new request by modifying the attributes of existing requests.
• Cancel the scheduled execution of selected jobs
• Delete a job and the scheduled request will still be available in the system if 

you scheduled it to run daily, weekly, or monthly
• Delete requests so all jobs associated with that request are also deleted
• Drop the results table or file associated with selected requests
• Retrieve job results data using Teradata SQL Assistant
• Clean up (drop) results tables and files
• View the status of jobs
• View information about schedule request properties for a job
Teradata Dynamic Query Manager User Guide 1 – 3
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DQM Architecture
DQM Architecture

The DQM client/server architecture for scheduled requests includes:

• Client components running on NT 4.0, 2000 and XP
• Server components running on Windows NT 4.0, 2000 and XP
• Teradata DQM Administrator utility running on NT 4.0, 2000 and XP

The following figure shows the DQM client/server architecture.

Figure 1-1    DQM Client/Server Architecture for Scheduled Requests

For information about the Server component or Teradata DQM Administrator, 
see the Teradata Dynamic Query Manager Administrator Guide.

Administrator Utility
Windows PC 

2496A001

Windows 
Server

Windows PC
Client

request

response

DQM Database

Teradata CLIv2

DQM
Scheduled
Request 
Server

DQM
Scheduled
Requests

Viewer
Application

DQM
Scheduled
Requests

Client
Library
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Installation Information
Installation Information

Supported Client Platforms
• Windows NT 4.0
• Windows 2000
• Windows XP

Software Installation

The client components for this release of Teradata DQM are not compatible 
with those of earlier releases of Database Query Manager (DBQM).

Required Client Software

You must install the following software on a client system:

• TCP/IP driver with WinSock support (Version 1.1 or later) for Windows
• Ethernet or Token Ring packet driver compatible with the above
• Teradata CLIV2 release 4.7.1 or greater

Optional Client Software

You may install the following optional software on a client system:

• Teradata ODBC Driver for Windows
– Install the Teradata ODBC driver for Windows if you want to use 

Teradata SQL Assistant (previously known as Queryman).
• Teradata SQL Assistant 

– Install Teradata SQL Assistant for scheduling requests that were 
rejected due to DQM rules (see page 2-13) and for retrieving job result 
data (see page 3-12).

For more installation information, refer to the Teradata Tools and Utilities 
Installation Guide for Microsoft Windows.
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Software Configuration
Software Configuration

If you are using the Teradata DQM Scheduled Requests Viewer application, no 
configuration should be necessary. The viewer application will temporarily 
establish a database session through CLIV2 to validate the database logon 
parameters and find the location of an active DQM Scheduled Requests Viewer. 

If, for some reason, CLIV2 cannot establish a database session or you want to 
access the Teradata DQM Scheduled Requests client library functions directly, 
you can configure a default DQM server location. You will then be able to use 
the library functions.

How to Specify Server Names

Follow this procedure to specify a DQM server name:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, choose the Configurations menu, and select Communications.
The Communications Parameters dialog box opens.

2 Enter the following information in the Client fields in the Communications 
Parameters dialog box:

Table 1-1    Communications Parameters Dialog Box Field Descriptions

Field Description

Default Server Port 
Number

Enter the default IP port number for a remote DQM 
server(s). This value is used if a client does not specify a 
port number when opening a new communications 
session. The default port number is 3000.

Default Server 
Name

Enter the network node name or address of a DQM 
server. 
Teradata Dynamic Query Manager User Guide1 – 6



Chapter 2: 

Scheduled Requests

This chapter describes scheduled requests and contains the following 
information:

• Introduction 
• Connecting to a DQM Server 
• Scheduling an SQL Request 
• Submitting Scheduled Requests 
• Scheduling Requests Using Teradata SQL Assistant 
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Introduction
Introduction 

DQM accepts single- or multiple-statement query requests for scheduled 
execution at a later time. These scheduled requests are subject to the same 
DQM rule checking as interactive requests.

The Scheduled Requests component allows you to submit query requests for 
off-line (scheduled) execution. Scheduling information can be provided that 
dictates preferences as to when a request should be run, to a granularity of one 
minute. The scheduling information is used by the DQM server as the intended 
start time for the request. However, due to rules or no execution time frames, 
the request may not be run until some time after the requested start time. 
Therefore, you can also specify a maximum start interval for the request, 
essentially specifying the desired time period (up to one month) in which the 
request may be run. DQM will immediately reject a submitted request if there is 
no time between the start time and the start interval that a rule does not apply 
and a scheduled request execution time frame is not available.

Through the scheduling information, you can also specify that a request be 
recurring, i.e., the request be run more than once. For example, a request may 
be set up to run daily, weekly or monthly. Therefore, because a scheduled 
request may actually be executed many times, the term request is used to mean 
the actual definition of the scheduled request parameters, and the term job is 
used to mean an individual instance that a scheduled request is scheduled to 
run. 

The Scheduled Requests component of DQM may be enabled or disabled by 
your DBA using the Teradata DQM Administrator utility.

Execution Time Frames

Your DBA can control when DQM will execute scheduled requests by 
specifying one or more Scheduled Requests execution time frames. These are 
time periods in which the DQM server may execute scheduled requests. 

Your DBA can enable or disable execution time frames using the Teradata DQM 
Administrator utility. The specification of active execution time frames is 
required. If no execution time frames are defined or enabled, no scheduled 
requests will be accepted or run.

Automatic Scheduling

DQM provides automatic scheduling using Teradata SQL Assistant (previously 
known as Queryman). If Teradata SQL Assistant issues a request that is 
restricted by DQM at the current time, it can be scheduled for later execution. 
Teradata Dynamic Query Manager User Guide2 – 2
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Introduction
If the Scheduled Request client software is installed on the same system, the 
Teradata DQM Submit Scheduled Request dialog box displays to collect 
scheduling information and the request is submitted for scheduling.

Note:  You must have Queryman version 5.2 or Teradata SQL Assistant version 
6.0 or later. 

Saving Result Data

For many scheduled requests, especially automatically scheduled requests, it 
may be inconvenient for you to make the request self-contained, that is, to have 
the request save its own result data. In the case where a request does not save 
its own results, DQM can save the results, but only from the last statement in a 
scheduled request.

In order to do this, DQM requires that the last statement in the scheduled 
request be a SELECT statement. When the request is submitted, you must 
specify a valid database and table, or a valid server file name, in which to store 
the results.

If the results table or file already exists when the scheduled request is run, 
DQM will abort the job execution and mark it as failed, or destroy the results 
table if so specified. DQM will then recreate the table with the proper column 
types in order to store the data from the last statement.

To change this information, see the Results field described in Table 2-1 on page 
2-10. 

Immediate Execution

Using the Teradata DQM Administrator utility, your DBA can monitor and 
manipulate the scheduled requests job queue. By changing the state of a 
scheduled request job, your DBA can execute the job immediately, i.e., within 
five minutes, or cancel the job.

Checking Submitted Requests

When you submit a scheduled request, DQM does the following:

• Checks the objects referenced in the request against any rules that might 
prevent the request from ever running during the specified time period. If 
such rules exist, the request is rejected.

• Checks Scheduled Request execution time frames for availability during the 
specified time period when rules do not apply. If no execution time frames 
are available during these times, the request is rejected.

• Schedules the first job for the request. Unique IDs are generated for the 
request and its first job.
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Introduction
Dispatching Jobs

The DQM server monitors the scheduled request jobs, determines when jobs 
are to be run, and dispatches the DQM job execution program to run these 
requests. The DQM job dispatcher is aware of established execution time 
frames that dictate when the job executors are allowed to run. It is also aware of 
how many job executors are allowed to run simultaneously.

Executing Jobs

The DQM job execution program works through the following steps when 
attempting to run a scheduled request job:

1 Retrieves information about the request from the DQM database.

2 Rechecks any rules that might prevent the request from running. If such 
rules now exist, the job is rescheduled to a time when rules no longer apply.

3 Logs on to the database as the user, with an optional account name.

4 If a results table/file was specified and the results table/file currently 
exists, the job fails unless the user specified that the results could be 
deleted.

5 Runs the request.

6 If a DQM workload limits restriction is encountered, the job is rescheduled 
for 15 minutes later.

7 If a results table/file was specified, the last statement of the scheduled 
request is first run in ‘prepare’ mode to obtain the column types and names 
of the result data, the result table/file is recreated with those column types, 
if necessary, and the last statement (a SELECT statement) is run. The result 
data is written to the results table/file.

When a job needs to be rescheduled, an updated execution time is computed. If 
the updated time exceeds the start interval for the job, the status of the job is 
marked as canceled, because it would not have been completed within its 
execution time frame.

Character Sets

DQM can store scheduled request text internally in either ASCII or Shift-JIS 
character sets. DQM will perform the necessary conversions, if possible, from 
the user character set, which can be ASCII, Shift-JIS, or ‘packed format’ EUC. 
However, if DQM is internally using the ASCII character set, it will not accept 
Shift-JIS or EUC text that contains non-ASCII characters. On the other hand, if 
DQM is using the shift-JIS character set internally and the user is expecting 
ASCII, DQM will return the Shift-JIS text to the user anyway.
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Introduction
Automatic Cleanup

Your DBA can define the number of days that a history of completed jobs and 
un-updated results should be retained before being automatically deleted by 
DQM. This function is provided in the Teradata DQM Administrator utility 
and is part of the scheduled requests profile feature.

Scheduling SQL

You can use the Teradata DQM Scheduled Requests Viewer to schedule a new 
SQL request at any time. This is further discussed in Chapter 3.
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Connecting to a DQM Server

To schedule a request, you must connect to a DQM server.

How to Connect to a DQM Server

Follow this procedure to connect to a DQM server:

1 From the Windows task bar, click Start, then choose Programs. Then select 
Teradata DQM Utilities 5.01 and then Schedule Viewer.

2 From the Command menu, choose Connect or press .

3 During startup, you are automatically prompted to connect to a DQM 
server using the Teradata DQM Scheduled Requests Viewer Connect 
dialog box.

4 In this dialog box, enter the DBC Name, User Name and Password for your 
Teradata database account. Adding information into the Default Database 
and Account String text box is optional. 

5 If necessary, enter the TDQM Server. This information is the name or 
address of a system upon which the DQM server is running. 

Note:  The DQM server field is initially disabled. When you press OK, the 
Viewer will attempt to make a CLIV2 connection to validate the Teradata 
logon parameters and obtain information about the active Scheduled 
Request servers. If an active server is found, the Viewer will establish a 
connection. If there is a CLI error, the Viewer will attempt to establish a 
connection with the Server Name configured in the Teradata DQM 
Scheduled Requests Operations utility. If this is unsuccessful, the TDQM 
Server field is enabled and you can enter the name of a Scheduled Requests 
server. After clicking OK, the Viewer will attempt to establish a connection 
with the server named in the TDQM Server field.

6 Click OK. 
The parameters are validated and the Teradata DQM Scheduled Requests 
Viewer opens.

At any time you can disconnect and then connect again as the same user or a 
different user. 

Supporting Kanji Data

You need to modify (or localize) the Kanji character set in the CLIV2 clispb.dat 
file in order to support using Kanji data. 

To modify the clispb.dat file, you need to follow the steps below.
Teradata Dynamic Query Manager User Guide2 – 6



Chapter 2: Scheduled Requests
Connecting to a DQM Server
1 Edit the CLIV2 clispb.dat file under the System32 directory with any text 
editor, such as Notepad.
Add the following two parameters after the last line.

charset_type=N

charset_id=KANJISJIS_OS 
Save your file.

2 Go to your Start menu and select Settings >  Control Panel > System. 

3 Select the Advanced tab, and then click Environment Variables.

4 Click New to add a new variable, and then enter COPLIB.

5 Specify the path to the clispb.dat file in the Value field, and then click OK.

6 Click OK to save your settings and exit.

Your CLIV2 connections will now support the Kanji session character set.
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Scheduling an SQL Request

The Teradata DQM Submit Scheduled Request dialog box is a Windows 
dynamic link library (tdqmsubm.dll). It is used by Teradata SQL Assistant 
(previously known as Queryman) and the Teradata DQM Scheduled Requests 
Viewer so you can schedule an SQL request. 

You use this dialog box to schedule an SQL request to a DQM Scheduled 
Request server. All of the parameters you enter are checked for validity. Then, if 
the request is approved, a Request ID and Job ID appear for the scheduled 
request. If the request is not approved, you can change the parameters and 
submit the request again. For more information, see “Submitting Scheduled 
Requests” on page 2-9.

The Teradata DQM Submit Scheduled Request dialog box is also invoked by 
the Teradata DQM Scheduled Requests Viewer to view or modify the 
properties of an existing scheduled request: 

• In the view mode, the fields are read-only and cannot be modified.
• In the modify mode, you can change any of the properties and submit 

another request. To change from view mode to modify mode, click Modify.
For more information, see “Modifying Previous Requests” on page 3-7.

Note: SQL requests that insert Large Object (LOB) data into the database 
are not supported. However, you can schedule requests that retrieve LOB 
data and save the data into results tables and files.  
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Submitting Scheduled Requests

You schedule an SQL request to a DQM Scheduled Requests server.

How to Submit a Scheduled Request

Follow this procedure to schedule an SQL request:

1 From the Windows task bar, click Start, then choose Programs. Then select 
Teradata DQM Utilities 5.01 and then Schedule Viewer.

2 Connect to a DQM server if you have not done so. For information, see 
page 2-6.

3 From the Command menu, choose Schedule SQL or press . 

4 Using the SQL Text dialog box, enter the SQL statement(s) you want to 
schedule. 

Figure 2-1    SQL Text Dialog Box

You can either type the SQL statement(s) directly into the dialog box text 
edit area or copy (Ctrl+c) the SQL from another tool and paste (Ctrl+v) it 
into the text edit area.

5 Click OK.
The Teradata DQM Submit Scheduled Request dialog box opens. See 
Figure 2-2 on page 2-12.

6 Enter the parameters for your new SQL request. See Table 2-1 on page 2-10 
for more information on the parameters.

7 Click OK to submit a request to the DQM Scheduled Requests server. 
All of the parameters you enter are checked for validity. Then if the request 
is approved, a Request ID and Job ID appears for the scheduled request in a 
message window. 
Teradata Dynamic Query Manager User Guide 2 – 9



Chapter 2: Scheduled Requests
Submitting Scheduled Requests
If the request fails to be approved, you will be given the chance to change 
the parameters and submit the request again. 
To cancel the request at any time, click Cancel.

Table 2-1    Scheduled Requests Dialog Box: Field/Button Descriptions

Field/Button Description

SQL View one or more SQL statements, delimited by semicolons. The statements in this text 
box are read-only. You created the statements from the SQL Text dialog box or using 
Teradata SQL Assistant.

Estimates 
(time/rows)

View the estimated time and rows the request is expected to execute and generate, 
respectively. These values are calculated by the DQM server from the EXPLAIN 
statement that is run on the request. This information is read-only. You cannot edit them.

Update This button is enabled when one or more characters of the SQL text of a request is 
changed.

Retrieves information about the new request you entered in the SQL text box from the 
Teradata DQM Scheduled Requests server and displays the following information for 
the new request:

• Whether the new request will generate results 
View the Results section in the bottom right corner.

• Time and row estimates for the new request 
View the time and row estimates underneath the SQL text box.

User Name View your Teradata database logon name. This information is obtained from the 
Teradata DQM Scheduled Requests Viewer or Teradata SQL Assistant and is read-only. 
You cannot edit it.

Account String View your Teradata database account string This information is obtained from the 
Teradata DQM Scheduled Requests Viewer or Teradata SQL Assistant and is read-only. 
You cannot edit it.

Request Name Enter a user-defined name for the request (optional).

E-mail address for 
notification on 
completion

E-mail address where DQM will send a notification message when a request job finishes 
execution. This field is editable depending on the profile type and is optional.

For information on installing and configuring the software to enable this feature, see the 
Teradata Dynamic Query Manager Administrator Guide.

Scheduling:

Frequency Choose the frequency in which the request will run. The default is Once. This indicates 
the scheduled SQL will execute just one time.

• Once
• Daily
• Weekly
• Monthly

Depending on your profile, all of the frequencies may be disabled except for Once.
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Start Days/Dates Enter the date, days of the week, or dates of the month the request should be executed.

Selecting a different frequency may change these values. This is set to the first date and 
time computed by the DQM server when no restrictions apply to the request and when a 
scheduled request execution time frame is available.

Start Time Enter the time the request should be executed. The default values indicate the next time 
the DQM server predicts the request will be able to be executed.

Maximum Start 
Interval

Enter the maximum job execution interval in days and hours, beyond the start time, you 
want the job to begin to execute. For new requests, the initial value is determined by the 
profile type.

The default value is defined by the Teradata DQM Administrator utility.

Results: This group of controls specify where and how the results of the scheduled request are to 
be saved. If no results are generated, these controls are disabled. These fields are 
selectable depending on the profile type.

Save Results To Select where the results from the last statement of the query are to be stored:

• Database Table
• Text File

The default value is defined in the Teradata DQM Administrator utility.

Database Name Enter the database name in which DQM will store the results from the last statement 
when it is run. When results are saved to a database table, this field is initialized to a 
default database name that is defined in the Teradata DQM Administrator utility.

Table/File Name Enter the database table name or the text file name in which DQM stores the results from 
the last statement when it is run. 

Database Options When creating a database table, choose the type of tables created (optional):

• Fallback
• Multiset

Result Options Choose whether the results should 

• Append if exists: Appended to an existing table/file
• Drop if exists: Stored after dropping the existing table/file. This option is the default.
• Fail if exists: Not stored if scheduled request failed due to the result table/file 

already existing

Table 2-1   (Continued)  Scheduled Requests Dialog Box: Field/Button Descriptions

Field/Button Description
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Following is a sample of the Teradata DQM Submit Scheduled Request dialog 
box:

Figure 2-2    Teradata DQM Submit Scheduled Request Dialog Box

Field Separator Choose the character field separator for results that are to be saved to a file. The default 
value is defined by the Teradata DQM Administrator utility. The values are:

• Tab
• Space
• Semicolon
• Comma
• Bar |

Automatically 
cleaned up after

The number of days the results are saved before being automatically deleted by DQM. 

This value is set by the Teradata DQM Administrator utility and is read-only. It cannot 
be edited. 

Table 2-1   (Continued)  Scheduled Requests Dialog Box: Field/Button Descriptions

Field/Button Description
Teradata Dynamic Query Manager User Guide2 – 12



Chapter 2: Scheduled Requests
Scheduling Requests Using Teradata SQL Assistant
Scheduling Requests Using Teradata SQL 
Assistant

DQM can save and schedule any query to execute at a later time. You may need 
to do this because the query was rejected at the time it was executed due to 
DQM rules. To schedule a query that was rejected because of rules, you must 
use Teradata SQL Assistant.

Teradata SQL Assistant is a Windows ODBC application that issues SQL 
requests to a database. If Teradata SQL Assistant detects that a query has been 
rejected by a Teradata database due to a TDQM error (statuses 3149-3150), it 
will attempt to schedule the request for batch execution using the Teradata 
DQM Scheduled Requests client software.

How to Set Up Automatic Scheduling

You must complete the following steps for your query to automatically be 
scheduled using Teradata SQL Assistant:

1 Ensure the Teradata DQM Scheduled Requests client software is installed 
on your system.

2 Ensure the DQM client is configured to allow scheduling of rejected 
requests. See page 4-4.

Steps Your DBA Must Complete

Next, your DBA must complete the following steps:

1 Ensure the Scheduled Requests feature is enabled using the Teradata DQM 
Administrator utility.

2 Ensure at least one Scheduled Requests server is running.

3 Ensure the request is not always restricted (24 hours a day, 7 days a week).

4 Using the Teradata DQM Administrator utility, your DBA ensures you have 
a scheduled requests profile to allow scheduling.

If the above steps have been taken, your query will automatically be scheduled 
using Teradata SQL Assistant.

For information about retrieving results using Teradata SQL Assistant, see 
“Retrieving Job Result Data” on page 3-12.
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Teradata DQM Scheduled Requests Viewer

This chapter discusses the Teradata DQM Scheduled Requests Viewer and 
contains the following information:

• Introduction 
• Teradata DQM Scheduled Requests Viewer Main Window 
• Viewing Scheduled Request Properties 
• Modifying Previous Requests 
• Retrieving Job Result Data 
• Deleting a Request 
• Canceling or Deleting a Job 
• Dropping Results 
• Retrieving Job Result Data 
• Viewing Job Result Information 
• Refreshing the Job List 
• Setting the Refresh Rate  
• Online Help and Copyright Information 
• Disconnecting from a DQM Server 
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Introduction

The Teradata DQM Scheduled Requests Viewer allows you to:

• View the status of DQM scheduled jobs
• View information about jobs and requests
• Submit new scheduled SQL requests
• View the Results Table for successfully completed jobs
• Cancel a job
• Delete jobs and requests
• Clean up (drop) results tables and files
• Retrieve a completed request’s result data (using Queryman 5.2 or later)

The Teradata DQM Scheduled Requests Viewer provides information for only 
the particular user that is logged on to the Teradata database (as opposed to the 
Teradata DQM Administrator utility, which provides information to the DBA 
about all scheduled requests and jobs). The DQM server must be up and 
running before the Teradata DQM Scheduled Requests Viewer can operate. 
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Teradata DQM Scheduled Requests Viewer 
Main Window

To open the Teradata DQM Scheduled Requests Viewer from the Windows task 
bar, do the following:

Note: Connect to a DQM server, if you have not already done so. For 
information on connecting to a DQM server, see “Connecting to a DQM 
Server” on page 2-6.  

1 Go to your Start menu, and then choose Programs > Teradata DQM 
Utilities 5.1. > Schedule Viewer. 

2 Enter your DBC Name and Password.

3 Click OK. 

After you have successfully connected to a DQM server, your scheduled jobs 
are retrieved and displayed in the Viewer. The following information is 
displayed about each scheduled job the logged in user has currently in the 
system: 

Table 3-1    TDQM Scheduled Requests Viewer Column Descriptions

Column Name Description

Request Name View the name entered when the request was scheduled.

Req ID View a unique numeric ID generated by DQM identifying a 
request.

Job ID View a unique numeric ID generated by DQM identifying a job.

Schedule View the current scheduled run time.

Max. Start Time View the latest time the job can begin execution.

Status View the current status of the job.

Information View information on how the job was completed, such as 
database error, rows returned, and more.
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Figure 3-1    Teradata DQM Scheduled Requests Viewer Main Window

Menu Bar

You can use the menu bar in the Teradata DQM Scheduled Requests Viewer 
main window to access all of the functions for the viewer.

You can also right-click on any request in the Teradata DQM Scheduled 
Requests Viewer main window and a shortcut menu appears with a menu of 
most functions.

Toolbar

The Teradata DQM Scheduled Requests Viewer main window also has a 
toolbar with icons you can click as a shortcut to the more commonly used 
features. When you open the viewer, you will notice that only a few of the 
buttons in the toolbar are available. Toolbar buttons appear gray when you 
cannot use the related function.

Specifically what features these buttons are for is discussed throughout the rest 
of this chapter.

Status Bar

The status bar at the bottom of the screen displays important information. The 
status of the Teradata DQM Scheduled Requests Viewer for the currently 
Teradata Dynamic Query Manager User Guide3 – 4



Chapter 3: Teradata DQM Scheduled Requests Viewer
Teradata DQM Scheduled Requests Viewer Main Window
selected menu item is shown in the bottom left corner. Following the status 
information are four user information panes showing the following:

Requests: The number of scheduled requests you have in the system.

Jobs: The number of scheduled jobs.

Timeframe: The current or next Scheduled Request execution time frame (the 
DBA uses the Teradata DQM Administrator to set Scheduled Requests 
execution time frames).

Database: The current database date and time.

Sorting Columns

The information displayed in the Teradata DQM Scheduled Requests Viewer 
main window can be sorted by any column. To do this, click the column 
headings at the top of the columns. This sorts the requests in ascending order.
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Viewing Scheduled Request Properties

The Teradata DQM View Scheduled Request dialog box has information 
about schedule properties for a job you select in the Teradata DQM Scheduled 
Requests Viewer. 

The information in this dialog box is read-only. You cannot modify it; however, 
you can change any of the properties and submit another request. For more 
information, see “Modifying Previous Requests” on page 3-7.

How to View Scheduled Request Properties

Follow this procedure to view Scheduled Request properties: 

1 From the Teradata DQM Scheduled Requests Viewer, go to the View menu.

2 Choose Request Properties or press .
The Teradata DQM View Scheduled Request dialog box opens.

Figure 3-2    Sample Teradata DQM View Scheduled Request Dialog Box
Teradata Dynamic Query Manager User Guide3 – 6



Chapter 3: Teradata DQM Scheduled Requests Viewer
Modifying Previous Requests
Modifying Previous Requests

The Teradata DQM Submit Scheduled Request dialog box is invoked by the 
Teradata DQM Scheduled Requests Viewer to view or modify the properties of 
an existing scheduled request: 

• In the view mode, the fields are read-only and cannot be modified.
• In the modify mode, you can change any of the properties and submit 

another request.

How to Modify a Previous Request and Submit

Follow this procedure to modify a previous request and submit another 
request:

1 From the Windows task bar, click Start, then choose Programs. Then select 
Teradata DQM Utilities 5.01 and then Schedule Viewer.

2 Connect to a DQM server if you have not done so. For information, see 
page 2-6.

3 From the Teradata DQM Scheduled Requests Viewer, double-click a 
previously submitted request.

4 From the Teradata DQM View Scheduled Request dialog box, click 
Modify. 

5 Change any of the enabled fields and click Submit. 
If the new request is submitted successfully, a message box appears with 
your Request ID number and Job ID number. 

6 Click OK.

7 You are prompted to delete the original request. Click Yes to delete the 
original request. Otherwise, click No. 

If you click No, your new request appears in the Viewer. Your original 
request remains in the Viewer.
If you click Yes, another message asks if you are sure you want to delete all 
jobs associated with the selected request. 
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8 Click Yes if you want to delete all jobs associated with the selected request. 
Otherwise, click No.
If you click No, your request appears in the Viewer.

9 Click Yes if you want to drop the results for the request. Otherwise, click 
No.
If you click No, your request appears in the Viewer.

10 Click Yes if you want to drop the results for the request. Otherwise, click 
No.
If you click Yes, the results for the request are dropped and your new 
request appears in the Viewer.
If you click No, the results for the request are not dropped and your new 
request appears in the Viewer.
Teradata Dynamic Query Manager User Guide3 – 8



Chapter 3: Teradata DQM Scheduled Requests Viewer
Deleting a Request
Deleting a Request

The Delete Request command allows you to delete a selected scheduled 
request. When a request is deleted, all jobs associated with that request will also 
be deleted. 

How to Delete a Request

Follow this procedure to delete a request:

1 From the Teradata DQM Scheduled Requests Viewer, go to the Option 
menu.

2 Choose Delete Request. 

There is no toolbar shortcut for this command.
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Canceling or Deleting a Job

The Cancel Job command allows you to cancel the scheduled execution of a 
selected job. The Cancel Job command will work only for a job that has a status 
of “waiting”. Once the job is canceled, it cannot be restarted. A new request 
must be submitted or, if it is a recurring request, a new job will be generated 
automatically by DQM before the next day.

How to Cancel a Job

Follow this procedure to cancel a job:

1 From the Teradata DQM Scheduled Requests Viewer, go to the Options 
menu.

2 Choose Cancel or press .

The Delete Job command allows you to delete a selected job. Completed jobs 
may be deleted as required to save space and allow for faster updates of the job 
list in the Viewer’s main window. Jobs are also deleted periodically as specified 
by the Teradata DQM Administrator utility. Only jobs that have a status of 
"Complete" can be deleted. You cannot delete a job with a status of “Waiting." 
You can delete a job and the scheduled request will still be available in the 
system (unless the job is for a one-time request). 

How to Delete a Job

Follow this procedure to delete a job:

1 From the Teradata DQM Scheduled Requests Viewer, go to the Options 
menu.

2 Choose Delete or press .
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Dropping Results 

The Drop Results command allows you to drop the results table or file 
associated with the selected request. This command allows you to clean up 
results tables or files that have been generated for the request. 

If you wish to use the same results table or file for each request, then the results 
must be dropped or the Drop if exists option must be selected when 
scheduling requests. For information on this option, see Table 2-1 on page 2-10.

How to Drop Results

Follow this procedure to drop results:

1 From the Teradata DQM Scheduled Requests Viewer, go to the Option 
menu.

2 Choose Drop Results. 

There is no toolbar shortcut for this command.
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Retrieving Job Result Data 

The Retrieve Results command allows you to retrieve the result data for any 
selected job that has a status of complete. 

Note: This command is available only if Queryman, version 5.02 or later, or 
Teradata SQL Assistant 6.0 is installed on your system.  

The presence of Teradata SQL Assistant is automatically checked each time the 
Teradata DQM Scheduled Requests Viewer is started. By selecting a completed 
job and activating this command, Teradata SQL Assistant is launched with the 
SQL to retrieve the result data from the job’s results table or file. 

How to Retrieve Results From Server Text File

To retrieve results from the server text file, follow this procedure:

1 From the Teradata DQM Scheduled Requests Viewer main window, select a 
job with a status of "Completed."

2 From the View menu, choose Retrieve Results or press the Retrieve Result 
Data button   .

3 When retrieving a results file, you will be prompted for a local file name in 
which to copy the results before invoking Teradata SQL Assistant with the 
local file name.

4 Teradata SQL Assistant opens and retrieves your results and loads it into a 
Teradata SQL Assistant answer set window. 
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How to Retrieve Results From a Database Table

To retrieve results from a database table, follow this procedure.

1 From the Teradata DQM Scheduled Requests Viewer main window, select a 
job with a status of "Complete."

2 From the View menu, choose Retrieve Results or press the Retrieve Result 
Data button .

3 You are prompted for an ODBC data source.
a From the Select Data Source dialog box, select the Machine Data Source 

tab.
b Choose the appropriate Data Source Name and click OK.

4 Teradata SQL Assistant opens and retrieves the results and loads it into a 
Teradata SQL Assistant answer set window. 

To save an answer set to a file, refer to the Teradata SQL Assistant for Microsoft 
Windows User Guide.

Note:  Each time this command is activated, a new instance of Teradata SQL 
Assistant may be executed in order to allow multiple queries to run at once.
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Viewing Job Result Information

The Job Information command allows you to easily view the text from the 
Information column of the Teradata DQM Scheduled Requests Viewer. This 
text is often long and not completely visible in the list. 

How to View Job Result Information

Follow this procedure to view job result information:

1 From the Teradata DQM Scheduled Requests Viewer, go to the View menu.

2 Choose Job Information or press .

3 When you select a job and activate this command, the entire text is 
displayed in the Job Result Information message box.

4 Click OK.
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Refreshing the Job List

The Refresh command allows you to immediately update the jobs list with 
information from the DQM server.

How to Refresh the Job List

Follow this procedure to refresh the job list:

1 From the Teradata DQM Scheduled Requests Viewer, go to the View menu.

2 Choose Refresh or press .
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Setting the Refresh Rate

The Settings command allows you to set the refresh rate for the update of the 
jobs list from the server.

How to Set the Refresh Rate

Follow this procedure to set the refresh rate:

1 From the Teradata DQM Scheduled Requests Viewer, go to the View menu.

2 Choose Settings. 
The Scheduled Request Viewer Settings dialog box appears.

3 Set the refresh interval between 5 and 99 minutes. 
Although the refresh is a background process, it still adds to network traffic 
and should only be set as low as needed.

4 Click OK.
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Online Help and Copyright Information

Online Help

You can open the Teradata DQM Scheduled Requests Viewer online help 
system at the contents level. From the Help menu, choose Contents.

You can also open the online help system at the index level. From the Help 
menu, choose Search for Help on.

Copyright and Version Information

You can open the About Teradata DQM Scheduled Requests Viewer dialog 
box to see copyright and version information. 

From the Help menu, choose About TDQM Viewer or press .
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Disconnecting from a DQM Server

At any time, you may disconnect from a DQM server and close the Teradata 
DQM Scheduled Requests Viewer.

How to Disconnect from a DQM Server

Follow this procedure to disconnect from a DQM server:

1 From the Teradata DQM Scheduled Requests Viewer, go to the Command 
menu.

2 Choose Disconnect or press .
This clears the main window and prevents any further actions until you 
connect again. 

3 Click Yes to confirm you want to disconnect.

4 From the Command menu, click Exit. 
The Teradata DQM Scheduled Requests Viewer closes. 
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Teradata DQM Scheduled Requests 
Operations Utility

This chapter describes the features you can use with the Teradata DQM 
Scheduled Requests Operations utility and contains the following information:

• Introduction 
• Changing Configuration Parameters 
• Viewing Component Information 
• Teradata DQM Error Log Files 
• Enabling and Disabling Tracing 
• Teradata DQM Scheduled Requests Operations Menu Bar 
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Introduction

The Teradata DQM Scheduled Requests Operations utility provides operations 
for both DQM client and DQM server software programs. If only the DQM 
client software is installed, the operations of this utility that pertain to the DQM 
server will not be available. 

The DQM client software has some general functions used by all DQM 
components. These functions are explained below. 

Functions

The Teradata DQM Scheduled Requests Operations utility has the following 
operational functions for the DQM scheduled requests client components. You 
can do the following:

• Configure the communications and client parameters
• Display configuration and runtime information
• View, save, or delete the DQM error log files
• Enable and disable tracing

The Teradata DQM Scheduled Requests Operations utility menu bar and its 
commands are explained at the end of this chapter.
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Changing Configuration Parameters

There are three types of DQM configuration parameters: Communications, 
Client, and Server. Even though these parameters are stored in the Windows 
registry, you should change them using the Teradata DQM Scheduled Request 
Operations utility. As a user, you need to only know about communications 
and client configuration parameters. For information on server configuration 
parameters, refer to the Teradata Dynamic Query Manager Administrator Guide.

Some of the communications parameters are read only during the start up 
phase of the appropriate component. Depending on which configuration 
parameters you change, this utility and all the DQM software may need to be 
terminated and then restarted to take affect.

For a list of the default configuration parameters, see “Default Configuration 
Parameters” on page B-2. 

How to Change the Communications Parameters

You shouldn’t have to change any of the communications configuration 
parameters. The communications components also use these parameters to 
provide communication services to the DQM servers.

The communications parameters can be located as follows:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, choose the Configurations menu, and select Communications.
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The fields are described below.

To view the server fields, the DQM server software must be installed. If only 
the client software is installed, this section is unavailable. For more information 
on the server fields, see the Teradata Dynamic Query Manager Administrator 
Guide.

How to Change Client Parameters

You can specify the configuration parameters used by the client components on 
this system to customize preferences and to correctly interact with managed 
clients by using the Client Parameters dialog box.

Follow this procedure to change the client parameters:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, choose the Configurations menu, and select Client. 

Table 4-1    Communications Parameters Dialog Box: Field Descriptions

Field Description

Client: Important:  The Default Server Port Number and Default Server Name need to be 
specified only if you are calling the DQM client library functions from your own 
application. 

Otherwise, the Teradata DQM Scheduled Requests Viewer will use CLIV2 to find the 
address and port number of an active DQM server.

Default Server Port 
Number

Specifies the default IP port number for a remote DQM server(s). This value is used if a 
client does not specify a port number when opening a new communications session. The 
default port number is 3000.

Default Server 
Name

Specifies the default network node name or address of a remote DQM server. This value is 
used if a client does not specify a server name when opening a new communications 
session.

General:

Comm Shared 
Memory Size

Specifies the size, in kilobytes, of the shared memory that is used by all the DQM 
Communications components to store connection and message information. The default 
is 200.

Data Transfer 
Retries

Specifies the number of times the DQM Communications components retries system and 
network functions when a failure is encountered. The default is 1.
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2 Change the following fields:

Table 4-2    Client Parameters Dialog Box: Field Descriptions

Field Description

Display ’Submit 
Scheduled Request’ 
dialog for SQL 
Assistant queries 
rejected by TDQM

Select this check box to display the Teradata DQM 
Submit Scheduled Request dialog box. This dialog box 
enables you to schedule requests issued by the Teradata 
SQL Assistant application that have been rejected with a 
DQM status. (3149, 3150)

Request Timeout Specify the number of seconds (between 5 and 99) that 
the DQM software waits before timing out a request to 
the DQM server. The default is 10 seconds.
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Viewing Component Information

You can view information that the main DQM communications components are 
actually using at runtime. To view the server and scheduled requests 
components, the DQM server software must be installed.

How to View Communications Information

Follow this procedure to view communications information:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, go to the Information menu

2 Choose Communications.
The Communications Information dialog box opens and you can view 
information about the following: 
• Parameters
• Connections
• Client Processes
• Statistics

For more information about the Communications Information dialog box, 
refer to “Communications Information” on page A-2, access Help from the 
Help menu, or press F1 while the dialog box is open.
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Teradata DQM Error Log Files

Teradata DQM error log files are intended to provide NCR support personnel 
and users with a general description of problems that have occurred. 

The DQM error log file is called dqmlog. It always exists if errors have been 
logged. A different error log file is created for each date that a error log entry 
needs to be made. The error log file name is appended with the year, month, 
and date it was created. For example, dqmlog020712 was created to contain 
error log entries that occurred on July 12, 2002. If it is deleted, another will be 
created when needed.

The DQM components log all severe errors related to DQM to this file. Only 
DQM errors, and not user request errors, are logged. Database errors 
encountered when executing scheduled requests are not logged in the error file, 
but are saved in conjunction with the scheduled request being executed. 

The default DQM error log is in the c:\dqmlog directory. This actual location is 
specified during installation and saved in the Windows registry during DQM 
Client installation.

Figure 4-1    Sample Error Log File

For a description of the contents of the error log files, see “TDQM Error Log 
Files” on page B-4. 

How to View Error Log Files

Follow this procedure to view error log files:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, choose the Error Log menu, and select View to open the View Error 
Log Files dialog box. 
The error log files appear in the Error Log Files list.
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2 From the list, click once to highlight the file you want to view.

3 Click OK to open the View Error Log File dialog box.

4 After viewing the error log file, click OK to close the View Error Log File 
dialog box.

How to Save Error Log Files

Follow this procedure to save error log files:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, choose the Error Log menu, and select Save to open the Save Error 
Log Files dialog box.

2 Select the name of the error log file you want to save from the Error Log 
Files list, and click OK.

3 In the Save In list box, select a directory location to save the file.

4 Enter a file name in the File Name list box.

5 In the Save as Type list box, accept the default .txt file format.

6 Click Save.

How to Delete Error Log Files

Follow this procedure to delete error log files:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, choose the Error Log menu, and select Delete to open the Delete 
Error Log Files dialog box.

2 From the list, click once to highlight a file you want to delete or hold the 
Ctrl key and click multiple files to highlight.

3 Click OK to delete the file.

4 Click OK to confirm you want to delete the file or click Cancel to not delete 
the file.
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Enabling and Disabling Tracing

You can use a tracing function from the Teradata DQM Scheduled Requests 
Operations utility. Tracing writes special debugging information to text files. 
This information is useful when troubleshooting the system. 

When tracing is on, information regarding the DQM operation is saved to files. 
Depending on where the client software is installed, these files are typically 
located at c:\dqmlog. The DBA or technical support personnel can troubleshoot 
problems by viewing these files.

Depending on the problem you are resolving, tracing can be turned on 
selectively for each of the three DQM components. Tracing can be toggled on or 
off before or after the components have been started. This eliminates the need 
to stop and restart DQM components in order to change the tracing setting. 

Warning: Tracing can use a lot of disk space and can severely impact performance. You 
should use it only when resolving a problem. The default is no tracing.

How to Enable and Disable Tracing

Follow this procedure to enable or disable tracing:

1 From the menu bar of the Teradata DQM Scheduled Requests Operations 
utility, choose the Configurations menu and select Tracing.

2 From the Trace Teradata DQM Activity to Files dialog box, choose from 
the following:
• Enable Client Tracing to enable tracing of client DQM component 

activities.
• Enable Communications Tracing to enable tracing of communications 

component activities.
To enable server tracing, the DQM server software must be installed. If only 
the client software is installed, this check box is unavailable. 
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Teradata DQM Scheduled Requests 
Operations Menu Bar

The menu bar provides access to all the utility’s functions.

Figure 4-2    Teradata DQM Scheduled Requests Operations Menu Bar

File Menu

The File menu has a command that allows you to exit the Scheduled Requests 
operations.

Configuration Menu

The Configuration menu has commands that help you to configure parameters 
and activate tracing. The following table lists the commands you can perform 
from the Configuration menu:

Table 4-3    Scheduled Requests Operations: File Menu Command

Use this command... To...

Exit Close the Teradata DQM Scheduled Requests Operations utility.

Table 4-4    Scheduled Req. Operations: Configuration Menu Commands

Use this command... To...

Communications Open the Communications Parameters dialog box so you can 
configure communications parameters. 

Client Open the Client Parameters dialog box so you can configure 
client parameters.

Server Open the Server Parameters dialog box so you can configure the 
server parameters.

Tracing Open the Trace Teradata DQM Activity to Files dialog box so 
you can enable or disable tracing for the client, the server, 
and/or communications components of DQM.
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Server Menu

The Server menu has commands that control the DQM server if the server 
software is installed. The following table lists the commands you can perform 
from the Server menu:

Information Menu

The Information menu has commands that help you to view information about 
the components. The following table lists the commands you can perform from 
the Information menu:

Error Log Menu

The Error Log menu has commands that help you to view, reset, or save the file. 
The following table lists the commands you can perform from the Error Log 
menu:

Table 4-5    Scheduled Requests Operations: Server Menu Commands

Use this command... To...

Start Start the DQM server service.

Stop Stop the DQM server service and shut down all the DQM server 
components.

Table 4-6    Scheduled Requests Operations: Information Menu Commands

Use this command... To...

Communications Open the Communications Information dialog box so you can 
view information about the communications components.

Server Open the Server Information dialog box so you can view 
information about the server.

This command is only available if the DQM server software is 
installed.

For details about the Server Information dialog box, see the 
Teradata Dynamic Query Manager Administrator Guide.

Scheduled 
Requests

Open the Scheduled Requests Information dialog box so you 
can view information about scheduled requests.

This command is only available if the DQM server software is 
installed.
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Help Menu

The Help menu has commands that help you to access the online help and 
view information about this utility. The following table lists the commands you 
can perform from the Help menu:

Table 4-7    Scheduled Requests Operations: Error Log Menu Commands

Use this command... To...

View Display a dqmlog file.

Delete Delete one or more dqmlog files.

Save Save a copy of a dqmlog file into a text file so it can be sent to 
technical support.

Table 4-8    Scheduled Requests Operations: Help Menu Commands

Use this command... To...

Contents Open the Teradata DQM Scheduled Requests Operations utility 
online help at the Contents level.

Search for Help 
on

Open the Teradata DQM Scheduled Requests Operations utility 
online help at the Index level.

About TDQM 
Operations

Open the About Teradata DQM Operations dialog box 
containing copyright and version information.
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Communications Information

The Communications Information dialog box provides information about the 
communications components of DQM. From the menu bar of the Teradata 
DQM Scheduled Requests Operations utility, open the Information menu and 
select Communications.

The Communications Information dialog box includes the following tabs: 

The following tables give you information about the fields in each tab in the 
Communications Information dialog box.

Parameters Tab

The Parameters tab displays configuration and general runtime information 
about the DQM Communications components.

Figure A-1    Comm. Information Dialog Box: Parameters Tab

Table A-1    Information Dialog Box: Tab Descriptions

Tab Description

Parameters Configuration and general runtime information about the DQM Communications components.

Connections Information about the physical and logical communications connections.

Client 
Processes

Information about the client application processes that have attached to the communications 
library. 

Statistics Information about the number of communications connections and the requests sent over the 
connections.
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No modifications can be made to the actual fields in the Parameters tab. To 
modify information shown in this tab, from the menu bar of the Teradata 
Scheduled Requests Operations utility, open the Configuration menu and 
select Communications. The Communications Parameters dialog box opens.

Connections Tab

The Connections tab displays information about the physical and logical 
communications connections.

• The physical connections between client and server systems are managed 
by processes called routers. The router process that services the client end of 
a physical connection is a client router. The router process that services the 
server end is a server router. 

• The logical connections between client applications and the DQM server are 
called sessions. On client and server systems, all sessions to the same 
remote system are handled by a single router process.

Table A-2    Information Dialog Box: Box Descriptions

Box Description

Retries Indicates the number of times the DQM Communications components retries system and 
network functions when a failure is encountered.

Free Msg Buffers Indicates how many communications message buffers are currently available for use.

Memory Size (KB) The communications shared memory size in kilobytes.

Free Memory (KB) The amount of free communications shared memory in kilobytes.

Default Server 
Name

The default network node name of a remote DQM server system. This value is used if a 
client does not specify a server name when opening a new communications session.

Default Server Port The default IP port number for a remote DQM server system. 

Network Node 
Name

The name of the local network node if it has been used as a DQM server. 

Network Node 
Address

The address of the local network node. 

Listener Port The IP port number on which the DQM Listener component accepts socket connections 
from remote client systems.

This value is specified during Server installation and is saved in the 
<system>\system32\drivers\etc\ services file.

Listener Process ID The process ID of the DQM Listener process.
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Figure A-2    Comm. Information Dialog Box: Connections Tab

Client Processes Tab

The Client Processes tab displays information about the client application 
processes that have attached to the communications library. These are usually 
Scheduled Requests Viewer client applications.

Table A-3    Information Dialog Box: Connections Tab Field Descriptions

Field Description

Type Indicates whether the connection is a client or server router process or a logical session.

Local Id The hexadecimal identifier of the router or session on the local system.

PID/CSID PID is the process ID of the main router process for the router types. 

CSID is the hexadecimal identifier of the client or server sessions.

Sock State The state of the socket connection for the router types.

Send Msgs Indicates whether there are messages ready to send over the session or socket.

Shut/Disc Shut indicates whether there is a shutdown pending for router types. 

Disc indicates whether there is a disconnect pending for sessions.

Pend Msgs The number of messages waiting for a response on the session.

Total Msgs The total number of messages sent on the session.
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Figure A-3    Comm. Information Dialog Box: Client Processes Tab

Statistics Tab

The Statistics tab displays information about the communications connections 
and the requests sent over the connections.

Table A-4    Information Dialog Box: Client Processes Tab Field Descriptions

Field Description

Process Id The process ID of the process that opened a client communications session.

Session The session identifier of the session created for the process. Several sessions could be 
created by one client application process or thread.
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Figure A-4    Information Dialog Box: Statistics Tab

Table A-5    Information Dialog Box: Statistics Tab Field Descriptions

Field Description

Request Type The basic DQM communications request, or message, types.

Client Statistics:

Reqs Sent The number of requests of each type sent by client applications on the local system via the 
DQM client communications component. Because client applications do not send 
intermediate responses, that statistic is not applicable (n/a).

Resps Recvd The number of responses of each type received by client applications on the local system 
via the DQM client communications component. Because client applications do not 
receive responses for cancel and close-session requests, those statistics are not applicable.

Server Statistics:

Reqs Recvd The number of requests of each type received by the DQM server communications 
component on the local system from local and/or remote DQM client communications 
components.

Resps Sent The number of responses of each type sent by the DQM server communications 
component on the local system. The server communications component sends responses 
to the client communications component even if the client application does not receive 
them.

Server Resps The number of responses of each type returned by the DQM server component to the 
DQM server communications component on the local system. The DQM server responds 
to each request it processes.

Routers:

Connections The number of communications connections on the local system.
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Normal Discs The number of communications connections disconnected normally.

Time Outs The number of communications connections disconnected because of a timeout.

Errors The number of communications connections disconnected because of socket errors.

Table A-5   (Continued)  Information Dialog Box: Statistics Tab Field Descriptions

Field Description
Teradata Dynamic Query Manager User Guide A – 7



Appendix A: Communications Component Information
Communications Information
Teradata Dynamic Query Manager User GuideA – 8



Appendix B: 

Configuration Parameters and Error Log 
Files

This appendix contains the following information:

• Default Configuration Parameters 
• TDQM Error Log Files 
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Default Configuration Parameters

The following table lists the names of the configuration parameters as they 
appear in the Windows registry. 

Parameters that start with:

• Com are communication parameters
• Cli are client parameters
• Srv are server parameters (apply only if the system is being used as a DQM 

server)

Table B-1    Default Configuration Parameters

Parameter Default Description

ComShmSz 200 Communications shared memory size in kilobytes.

ComNMsgs 300 Number of Communications message structures to preallocate.

ComRetries 1 Number of times to retry network and system requests.

ComTracing No Trace Communications activity for debugging (normally No).

ComSrvPort 3000 Port number of remote DQM servers. Used as the default when 
the client does not provide one.

ComSrvName (2,3) None Up to three network names or IP addresses of remote DQM 
Scheduled Requests servers. The first one is used as the default 
when the client does not provide one.

ComSysName None Network node name of the local DQM server on the network used 
by the client systems to access the server. Used to override the 
gethostname values.

ComSysAddr None IP address of the local DQM server on the network used by the 
client systems to access the server. Must be specified with the 
ComSysName parameter.

CliSRDialog Yes Schedule rejected Teradata SQL Assistant queries. Set to No to 
disable display of Scheduled Requests Submit dialog box.

CliTimeout 30 Seconds to wait for server response.

CliTracing No Trace client activity for debugging

SrvShmSz 500 Server shared memory size in kilobytes.

SrvReqPool 3 Number of processes for request processing.

SrvTracing No Trace server activity for debugging (normally No).

SrvDbTdpid DBC Database logon tdpid.
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SrvDbName Dbqrymgr Database logon user name of the DQM database. Should always 
be dbqrymgr.

SrvDbPwd Dbqrymgr Database logon password for the dbqrymgr user. May be changed 
by the user (encrypted).

InstallPath C:\Program 
Files\NCR\ 
Teradata DQM

Location of the DQM installation directory

LogPath C:\dqmlog Location of the TDQM log directory for writing log and trace files 
(must be globally writable).

LogLevel 1 1 for log errors only or 2 for errors and other information.

Table B-1   (Continued)  Default Configuration Parameters

Parameter Default Description
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TDQM Error Log Files

The following tables give you information and describe the contents of your 
error log file.

The entries in the log file are described in Table 9-1.

Component Field

The Component field identifies what component or subcomponent of DQM is 
making the log entry. The following component identifiers are used in the 
TDQM log:

Table B-2    TDQM Log - Entry Fields

Column Description

Time The time that the log entry was made in hhmmss format where 
hh=hour, mm=minutes, and ss=seconds.

Component Abbreviated name of the Teradata DQM component or 
subcomponent when Teradata DQM logged the entry. The 
component identifiers used in the DQM log are:

• COMM - Communications
• INIT - Main (initialization) server process
• SRVR - Request processor server processes
• DBMS - Database interface module
• SRCLI - Scheduled Request client library
• SREXE - Scheduled Request job executor
• SCHED - Scheduled Request scheduler
• DISP - Scheduled Request dispatcher

Process ID The process ID that logged the entry.

Function Name of the function within the DQM code where the condition 
being logged occurred.

Activity Description of the activity or interface called by the Teradata DQM 
function that caused the entry to be logged.

Status DQM status value, or in some cases, the numeric value of a 
variable or a condition. See the following for the available status 
codes.

Errno Current system error number for the process. 

Message A log entry may be followed by one or more lines of text. A

text message is included when the logging of a status or errno 
value is insufficient, such as database errors.
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Status Field

The statuses logged by DQM are listed in the remainder of this section, and are 
grouped by the component that logs them. There are some general statuses that 
can be logged by any component.

Table B-3    TDQM Log - Component Identifiers

Identifier Component

COMM Communications

INIT Main (initialization) server process

SRVR Request processor server processes

DBMS Database interface module

SRCLI Scheduled Request client library

SREXE Scheduled Request job executor

SCHED Scheduled Request scheduler

DISP Scheduled Request dispatcher

Table B-4    TDQM Status Field - General Status Descriptions

Value General Status Description

0 General good status

99999 General failure status

50001 Invalid argument

50002 No memory available

50003 No semaphores available

50004 Bad semaphore operation

50005 Cannot put msg on queue

50006 Path or filename invalid

50007 Cannot start (exec) program

50008 Process terminated

50009 Server is inactive

50010 Server startup completed ok

50011 Server startup pending (initiated)

50012 Server startup required
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Table B-5    TDQM Status Field - Communications Status Descriptions

Value Communications Status Description

51001 Comm inactive (i.e., not started)

51002 No socket library

51003 No sockets available

51004 No host name specified

51005 Host name not found

51006 TCP service not found

51007 Socket connect failed

51008 Bad socket read

51009 Bad socket write

51010 Socket error

51011 Set sock option error

51012 Socket closed

51013 Interrupted socket read

51014 Invalid msg (bad key)

51015 Invalid msg (unknown msg type)

51016 Msg not found

51017 Cannot generate timestamp

51018 invalid session id

51019 comm listener terminated

51020 no response req’d - OK

51021 packet size mismatch

51022 product id error

Table B-6    TDQM Status Field - Server Vote Status Descriptions

Value Server Vote Status Description

53000 success vote

53001 error vote

53002 warning vote

53003 bypass vote
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53004 cancel vote

53005 server down vote

Table B-7    TDQM Status Field - Server Rule Status Descriptions

Value Server Rule Status Description

53100 no access rule

53101 no join rule

53102 query answer set size (rows) rule

53103 query processing time rule

53104 query spool size rule (not used)

53105 YNET usage threshold rule (no longer used)

53106 CPU usage threshold rule

53107 disk usage threshold rule

53108 network transit time threshold rule

53109 user logons threshold rule

53110 internal (software) error

53111 delayed queue max size exceeded

53112 delayed max time exceeded

53113 no scan rule

53114 retryable software error (i.e., database, UNIX resource, etc.)

53115 no scheduled request execution time frames available

53116 running query count threshold rule

53117 request already pending on session (software error)

53118 disk space threshold rule

53119 invalid request syntax

Table B-8    TDQM Status Field - Server Exception Status Descriptions

Value Server Exception Status Description

53201 unexpected keyword (in parsed object list)

53202 unexpected object kind (in update table)

53203 unexpected operation (in update table)

Table B-6   (Continued)  TDQM Status Field - Server Vote Status Descriptions
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53204 no objects specified (in update table)

53205 no SQL statement specified

53206 database error encountered

53207 object not found

53222 results table exists

Table B-9    TDQM Status Field - Scheduler Status Descriptions

Value Scheduler Status Description

56000 successful operation

56001 general error occurred

56002 invalid id specified

56003 bad date value specified

56004 database error encountered

56005 password mismatch

56006 scheduling not enabled

56007 for cancel or delete job

Table B-8   (Continued)  TDQM Status Field - Server Exception Status Descriptions

Value Server Exception Status Description
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C

Call-Level Interface Version 2 (CLIv2)   A collection of callable service routines that 
provide an interface to the Teradata Database. Specifically, CLI is the interface 
between the application program and the Micro Teradata Directory Program 
(MTDP). CLI builds parcels that MTDP packages for sending to the Teradata 
Database using the Micro Operating System Interface (MOSI), and provides the 
application with a pointer to each of the parcels returned from the Teradata 
Database.

E

error log file   A file containing a record of error conditions encountered by all 
DQM components on the system, and sometimes includes important events. It 
is a circular binary file of a fixed size that cannot be viewed with a text editor.

execution time frame   A period of time when DQM can execute scheduled 
request jobs that are waiting to run.

J

job   In the DQM Schedule Request environment, a job is the individual 
execution of an instance of a schedule request.

O

Open Database Connectivity (ODBC) Driver   A driver that allows client applications 
written with Microsoft ODBC standards to access the Teradata Database.

Q

query management    The primary feature of DQM is to enable your DBA to 
manage logons and queries. The Query Management capability examines 
logon and query requests before they are dispatched for execution with the 
RDBMS, and may reject logons, and may reject or delay queries. It does this by 
comparing the objects referenced in the requests to the types of DBA-defined 
rules. For more information, see the Teradata Dynamic Query Manager 
Administrator Guide.
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R

Relational Database Management System (RDBMS)   A database management system 
in which complex data structures are represented as simple, two-dimensional 
tables consisting of columns and rows.

request   In the DQM scheduled requests environment, a request is the 
definition of the parameters and text associated with a schedule request.

results table/file   In the DQM scheduled requests environment, a results table or 
file is a database table, or a Windows file into which DQM will store result data 
for a schedule request that is not self-contained.

rule   Rules are the name given to the method used by DQM to define what 
requests are prohibited from being immediately executed on the Teradata 
Database. That is, the rules enforced by DQM provide the Query Management 
capabilities.

S

scheduled requests   The capability to store scripts of SQL requests and execute 
them to run at a scheduled time later.

self-contained statement   A query request that stores the result data that it 
generates, if any. For example, an INSERT/SELECT statement would be self-
contained, whereas a SELECT statement would not.

T

Teradata Dynamic Query Manager (Teradata DQM and TDQM)   The product described 
in this document, which manages access to the Teradata database.

Teradata DQM Administrator Utility   An application used for establishing, 
monitoring, and administering DQM configuration and restriction parameters.

Teradata DQM Scheduled Requests Operations Utility   A Windows application that 
allows a user to configure the scheduled requests client environment on their 
PC, view information about client parameters, connections, processes, and 
statistics, and examine TDQM error log files.

Teradata DQM Scheduled Requests Viewer Application   A Windows application that 
allows the user to view the status of his or her scheduled jobs, view information 
about requests, submit new requests, cancel jobs, delete requests and jobs, and 
clean up results tables. The Viewer only provides information for the particular 
user that is connected to the DQM scheduled requests server. 
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Teradata SQL Assistant   Previously known as Queryman, Teradata SQL Assistant 
is a Windows applications that enables users to issue SQL requests to the 
Teradata Database.

tracing   This feature writes special debugging information to text files and is 
used when troubleshooting the system.
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